
MENG331 1 
 

  

  
 

EASTERN MEDITERRANEAN UNIVERSITY 

FACULTY OF ENGINEERING 

DEPARTMENT OF MECHANICAL ENGINEERING 
 

MENG 331 

DYNAMICS OF MACHINERY  

             LABS REPORT MANUAL 
                           (Fall 2021-2022) 

Instructor:   Assoc. Prof. Dr. Qasim Zeeshan 

Teaching Assistant/ Lab Instructor:  Mr. Tauqeer Nasir 
 

STUDENT NO: ………………………….  NAME, SURNAME: ………………………….………………….…………. 

STUDENT NO: ………………………….  NAME, SURNAME: ………………………….………………….…………. 

STUDENT NO: ………………………….  NAME, SURNAME: ……………………….…………………….…………. 

STUDENT NO: ………………………….  NAME, SURNAME: ……………………….…………………….…………. 

STUDENT NO: ………………………….  NAME, SURNAME: ……………………….…………………….…………. 

 

LAB PROJECT # 1: Modeling of a Discretized Lumped Parameter Spring Mass Damper System   

LAB PROJECT # 2: Damped and Undamped Free vibration response   

LAB PROJECT # 3: Balancing of Machines: Static and Dynamic Balancing 

LAB PROJECT # 4: Mode shape analysis of cantilever beam with ANSYS  

 

DUE DATE: 7 Jan 2022 

 

Instructions: Student Outcomes 
1. Answers are to be answered on the spaces provided 

under each section.  

2. Draw neat, labeled diagrams where necessary. Write 

relevant equations and write your Assumptions where 

necessary. 

3. Be clear and specific and include units in answers. Give 

explanatory notes where necessary. Please carry out 

each step explicitly. 

4. Please provide the references using APA Style of 

Referencing. References should be from the Textbook 

or from an authentic source.  

5. Please include the equations, diagrams, plots and 

figures in the report. 

6. All figures and Tables must be numbered and 

captioned. 

7. Please also submit the pdf Soft copy of the report and 

the together with the MATLAB codes, Simulink and 

Simscape Models, ANSYS Models, AVI File etc. 

8. The file/ folder uploaded should be named as  

[MENG331-LABS-GROUP NO- STUDENT IDS]  

9. Files with any other name or format will be 

disregarded. 
10. Late submissions will be penalized with reduction in 

total marks. 
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LAB PROJECT # 1:  

Modeling of a Discretized Lumped Parameter Spring Mass Damper System  
 

Model the Single Degree of Freedom Discretized Lumped Parameter System as Second 

Order differential Equation in MATLAB, Simulink and Simscape.  

You may use ODE45 variable step solver to solve the Second Order differential 

Equation. 

 

1. Choose any arbitrary values of Mass, Stiffness, and Damping, and plot the 

Amplitude, Velocity and Acceleration vs Time. 

2. Analyze the effect of change of Mass by plotting the results. 

3. Analyze the effect of change of Stiffness by plotting the results. 

4. Analyze the effect of change of Damping by plotting the results. 

5. Match the excitation force frequency with natural frequency and plot the 

resonance graphs. 
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Mechanical Systems 

Newton's laws of motion form the basis for analyzing mechanical systems. Newton’s second law, Equation (1), states that the sum of the forces 

acting on a body equals the product of its mass and acceleration. Newton's third law, for our purposes, states that if two bodies are in contact, 

then they experience the same magnitude contact force, just acting in opposite directions.  

                         (1) 

When applying this equation, it is best to construct a free-body diagram (FBD) of the sysetm showing all of the applied forces.  

 

Example: Mass-Spring-Damper System 

 

The free-body diagram for this system is shown below. The spring force is proportional to the displacement of the mass, , and the viscous 

damping force is proportional to the velocity of the mass, . Both forces oppose the motion of the mass and are, therefore, shown in the 

negative -direction. Note also that corresponds to the position of the mass when the spring is unstretched.  

 

Now we proceed by summing the forces and applying Newton’s second law, Equation (1), in each direction. In this case, there are no forces 

acting in the -direction; however, in the -direction we have:  

 

                                        (2) 

 

This equation, known as the governing equation, completely characterizes the dynamic state of the system. Later, we will see how to use this 

to calculate the response of the system to any external input, , as well as to analyze system properties such as stability and performance.  
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Mass-Spring-Damper in Simulink and Simscape 

This example shows two models of a mass-spring-damper, one using Simulink® input/output blocks and one using Simscape™ 

physical networks. 

The Simulink model uses signal connections, which define how data flows from one block to another. The Simscape model uses 

physical connections, which permit a bidirectional flow of energy between components. Physical connections make it possible to 

add further stages to the mass-spring-damper simply by using copy and paste. Input/output connections require rederiving and 

reimplementing the equations. 

The initial deflection for the spring is 1 meter. This is shown in the block annotations for the Spring and one of the Integrator 

blocks. 

Model 

 

Simulation Results from Simscape Logging 

 

ssc_mass_spring_damper_sl 
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LAB PROJECT # 2: Damped and Undamped Free vibration response   
 

APPARATUS: TM16 Universal Vibration Apparatus 

 
 

 

The TM16 series is a range of products that teach different aspects of vibrations and oscillations in 

mechanical systems. These include pendulums, mass-springs systems and shafts and beams. The TM16 series 

is a modular system, based around a Frame and Cupboard (TM16a). 
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Objective  

To determine the fundamental concepts of free vibration: 

 Damped 

 Undamped 

 

 

Apparatus  

TM16 Range Universal Vibration Apparatus  

 

Figure 1: TM16 Universal Vibration Apparatus  

 

Introduction 

A vibration is the movement of a physical quantity in relation to a reference location in a cyclically increasing and 

decreasing manner as a function of time. During vibrations, energy is dissipated and so a steady amplitude cannot be 

maintained without continuous replacement. Viscous damping in which force is proportional to velocity affords the 

simplest mathematical treatment. A convenient means of measuring the amount of damping present is to measure the 

rate of decay of oscillation. This is expressed by the term ‘logarithmic decrement’, which is defined as the natural 

logarithm of the ratio of successive amplitudes on the same side of the mean position. 

There are two types of vibration: (1) free vibration and (2) forced vibration. Free Vibration: A system is left to vibrate 

on its own after an initial disturbance and no external force acts on the system. Forced Vibration: A system that is 

subjected to a repeating external force. E.g. oscillation arises from motor. 
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Mechanical vibration classifications: (1) Damped Vibration: When any energy is lost or dissipated in friction or other 

resistance during oscillations, and (2) Undamped Vibration: When no energy is lost or dissipated in friction or other 

resistance during oscillations, finally (3) Resonance: It occurs when the frequency of the external force coincides with 

one of the natural frequencies of the system. 

 

Parts needed form the equipment 

 

 

Figure 2: Setup of the experiment 

 The exciter motor (F1) is not going to be used (but leave it fitted), free vibrations will be used. 

 To drive the chart recorder (D7) you need the Speed Control unit.  

 The system is set vibrating freely by pulling down on the free end of the beam a short distance (15 – 

25 mm) and releasing.  

 Use the chart recorder to obtain a trace of just three successive amplitudes on the same side of the 

mean position  

 FOR DAMPED: Vary the damping by moving the dashpot (D2) and its clamps along the beam, 

and also by relative rotation of the two orifice plates in the dashpot to increase or decrease the 

effective area of the piston  

 FOR UNDAMPED: Disengaged the damper and repeat above steps.   
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Procedure  

 Connect the lead from the motor of recorder unit D7 to the auxiliary supply socket on the Speed Control unit.  

 Switch on the speed control unit.  

 Set the dashpot at distance Ld (the distance from the trunnion mounting to the center of the beam clamp D9) 

 Bring the recording pen into contact with the paper to produce a trace of the decaying amplitude of vibration 

and thus produce a trace of the decaying applied amplitude on the chart recorder paper. 

 Pull the beam down a short distance, under the point of attachment of the spring, and release.  

 Start observing the system, its noise and from the chart recorder.  

 Gradually start increasing the speed from the motor speed control unit and observe. 

 

 

 

QUESTIONS: 
Briefly explain/ discuss the following: 

 

1. What type of damping are present in the system? 

 

2. Why is damping considered only in the neighborhood of resonance in most cases? 

 

3. How do you find the response of a viscously damped system under rotating 

unbalance? 

 

4. The equation of motion of a machine (rotating at frequency ) of mass M, with an 

unbalanced mass m, at radius e, is given by 

 

5. What happens to the response of an undamped system at resonance? 

 

6. Is it possible to completely avoid resonance of a damped during start up and stopping 

of a rotating machinery 

 

7. Is it possible to reduce the amplitude of resonance during start up and stopping of a 

rotating machinery 

 

8. The damping force depends on the frequency of the applied force in the case of a. 

viscous-damping b. Coulomb damping c. hysteresis damping? And Why, explain 

 

9. Is it possible to find the approximate value of the amplitude of a damped forced 

vibration without considering damping at all? If so, under what circumstances? 

 

10. Is dry friction effective in limiting the reasonant amplitude? 
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LAB PROJECT # 3: Balancing of Machines: Static and Dynamic Balancing 

 
 

APPARATUS: TM102 Static and Dynamic Balancing Apparatus 
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INTRODUCTION:  

 

A shaft with masses mounted on it can be both statically and dynamically balanced. If it is statically balanced, 

it can stay in any angular position without rotating. If it is dynamically balanced, it can be rotated at any 

speed without vibration. It will be shown that if a shaft is dynamically balanced, it is automatically in static 

balance, but the reverse is not necessary true.  

 

 Static Balancing  
Figure above shows a simple situation where two masses mounted on a shaft. If the shaft is to be statically balanced, 

the moment due to weight of mass 1, tending to rotate the shaft clockwise, must equal that of mass 2, trying to turn the 

shaft in the opposite direction. 

Therefore, the static balance is: 

W1rr = W2r2              1 

Similarly, the same principle holds for more than two masses, as shown in Figure 2. 

 
Figure 3: Static balancing of a simple two-masses system  

And for the static balancing: 

        2 

 

In general, the values of W, r and 𝛼 have to be chosen such that the shaft is in balance. Nevertheless, for experiments 

using TM102 apparatus, the product Wr can be measured directly for each mass, and only the angular positions have 

to be determined for static balance. If the angular positions of two masses are fixed, then the position of the third mass 

can be found, either by trigonometry or drawing. 
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Figure 4: Static balancing of three-masses system 
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 Dynamic Balancing 

As the shaft rotate the masses are going to be subjected to centrifugal forces. If the shaft is not to vibrate as it rotates, 

then two conditions must be satisfied:  

1. There must be no out-of-balance centrifugal force trying to deflect the shaft 

2. There must be no out-of-balance moment or couple trying to twist the shaft 

The shaft will not be dynamically balanced until these conditions are satisfied.  

 

Figure 5: 

 Applying condition 1 to the shaft in figure 3 gives: 

F1 = F2              3 

The centrifugal force is:  

        

Therefore; 

            4 

The angular speed of the rotation is the same for each mass, so that for the dynamic balance : 

W1r1 = W2r2              5 



MENG331 18 
 

Note: If a shaft is dynamically balanced, it will also be statically balanced. 

 The second condition will be satisfied by taking moments about some desired datum, like one of the 

bearings. Hence:  

a1F1 = a2F2             6 

Remember, F1 = F2, so as a1 = a2. Thus, in this case, dynamic balance can only be achieved if the two masses 

are mounted at the same point along the shaft. 

Note: If a shaft is statically balanced, it does not mean that it is dynamically balanced. 

 Dynamic Balancing of three Masses  

It has been shown that dynamic balance can only be achieved for a two-mass system if the masses are 

mounted at the same point along the shaft.  

It can also be shown that there are special conditions which must be satisfied for the dynamic balancing of 

three masses. 

 

Figure 6: Dynamic balance for three mass system 
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From figure 4(a), mass 3 is positioned vertically for convenience. From condition 2, dynamic balance can be 

expressed mathematically by equating moments for centrifugal forces in both vertical and horizontal planes. 

In order to simplify the equations, it is convenient to take moments about mass 1, so that moments due to 

forces on this mass are eliminated. 

 Horizontal : a2F2cos𝛼2 = 0          7 

 Vertical : a2F2sin𝛼2 = a3F3           8 

Conditions that can satisfy equation 7 are either a2 = 0, or 𝛼2 = 90 or 270 (that is cos𝛼2 = 0). The following 

conditions are obtained after substituting these in to equation 8: 

a) 𝛼2 = 0 

a3 must be zero for this condition. Thus, for any arbitrary values of 𝛼2 and 𝛼3, all three masses 

must be located qt the same point along the shaft. 

b) 𝛼2 = 90 or 270  

For these conditions, it is necessary to write down further equations to obtain solutions. 

Applying condition 1 for dynamic balance: 

 Horizontal : F1 cos𝛼1 =  F2 cos𝛼2          9 

 Vertical : F3 = F1 sin𝛼1 + F2 sin𝛼2          10 

If 𝛼2 = 90, equation 9 gives 𝛼1 = 90 or 270. Let’s assume 𝛼1 = 90, then equation 10 reduces to:  

 F3 = F1 + F2             

Similarly, equation 8reduces to: 

 a2F2 = a3F3             11 

Combine above equations to solve for F1. 

Therefore, If the masses are distributed along the shaft, the following conditions must b satisfied for dynamic 

balancing: 

1. Central mass at 180 degree to other two masses  

2. Masses chosen such that: 

F2 = F1 + F3   

3. Masses distributed along the shaft such that: 

a2F2 = a3F3  
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 Dynamic Balancing of More Than Three Masses 

If there are more than three masses, there are no special restrictions which apply to the angular and shaft-

wise distributions of the masses, and the general conditions for dynamic balance have to be applied to 

solutions.  

The angular positions of the masses can be determined by applying conditions for either static balance or for 

dynamic balance. The distribution of the masses along the shaft is then found by applying condition 1 for 

dynamic balance. This can be done by calculation. 

 

Figure 7: Nomenclature for Arbitrary Four-Mass System 
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The rotating moments are resolved into components tending to twist the shaft in the horizontal planes. The 

net moment on each plane must be zero if the shaft is to be dynamically balanced. As shown from figure 5, 

the appropriate equations for a four-mass system are:  

Horizontal moments about mass 1 

        12 

Vertical moments about mass 1 

         13 

PROCEDURE:  

 

 Demonstration of Static Balance by Dynamic Imbalance  

 Remove the Perspex dome and the shaft drive belt. 

 Remove the disc from the four rectangle blocks using the small hexagon key. Always take the blocks 

off the shaft before removing or replacing the discs. 

 Set up two of the blocks, as shown in figure 6, with the relative angular displacement of 180 degrees 

and shaft-wise displacement of 120mm. use the slider to set and read off the positions of the blocks 

of the blocks. 

 Observe that the shaft will remain in any angular position and is therefore statically balanced. 

 Connect the apparatus to a 12 VDC supply. Make sure that the slider adjacent to the linear scale is 

clear of the blocks, then replace the shaft drive-belt and the Perspex dome. 

 Run the motor. Note the severe imbalance of the shaft. 

 
Figure 8: Static Balance for Tow-Mass system 

 Dynamic Balance using Four Masses  

 Remove the Perspex dome and set up the four rectangular blocks as shown in figure 7 

 Make sure that theoretically the shaft is both statically and dynamically balanced (refer back to 

“Introduction and Theory” ) 

 Test the shaft for static balance. 

 Replace the drive-belt and the Perspex dome.  

 Run the motor and observe the lack of vibration, thus, showing that the shaft is dynamically balanced. 
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Figure 9: Static and Dynamic Balance for Four-Mass System 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



MENG331 23 
 

Problem to be solved 
 

Weights of 2 lb., 4 lb., and 3 lb. are located at radii 2in. ,3in. ,and 1in. in the planes C, 

D, and E, respectively, on a shaft supported at the bearings B and F, as shown in 

figure below. Find the weights and angular locations of the two balancing weights to 

be placed in the end planes A and G so that the dynamic load on the bearings will be 

zero.  
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QUESTIONS: 
Briefly explain/ discuss the following: 

 
1. What are the various methods available for vibration control? 

 

 

 

 

 

 

2. Why does dynamic balancing imply static balancing? and Explain why dynamic 

balancing can never be achieved by a static test alone 
 

 

 

 

 

3. What is the difference between stationary damping and rotary damping? 
 

 

 

 

4. What causes instability in a rotor system? 
 

 

. 

 

 

5. Why does a rotating shaft always vibrate? What is the source of the shaking force? 
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LAB PROJECT # 4: Mode shape analysis of cantilever beam with ANSYS  
 

AIM: 

To model and visualize the mode shapes of a cantilever beam. 

 

TOOL REQUIRED:  

ANSYS software  

 

BRIEF INTRODUCTION 

The modal analysis deals with the dynamics behavior of mechanical structures under the dynamics 

excitation. The modal analysis helps to reduce the noise emitted from the system to the environment. It 

helps to point out the reasons of vibrations that cause damage of the integrity of system components. Using 

it, we can improve the overall performance of the system in certain operating conditions. We know two 

basic methods of the modal analysis, namely the numerical modal analysis and the experimental modal 

analysis. The experimental modal analysis deals with measurement input data from which a mathematical 

model is derived. However, it has to take different levels of analysis, from which the model is constructed.  

 

METHODOLOGY  

 

Step 1: 

Modal (ANSYS) Project Selection 

Left, click on Modal ANSYS, and drag it to the right of the "Cantilever" project. You should then see a red 

box to the right of the "Cantilever" project that says "Create standalone system"  

 

 

 
 

Double click on the “Engineering Data” a new window will open as shown below. Next, to add your own 

new material  click on “click here to add new material” Name it whatever you want and press enter, eg 
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“ALUMINIUM” you should now have Aluminum listed as one of the materials in table called "Outline of 

Schematic B2: Engineering Data", as shown below. 

 

 

 
 

Then, (expand) Linear Elastic, as shown below. 

 

Now, (Double Click) Isotropic Elasticity. Then set Young's Modulus to 70e9 Pa and set Poisson's Ratio 

to 0.35 , as shown below 

 
 

Next, (expand) Physical Properties, as shown below 
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Now, (Double Click) Density. Then, set Density value , as shown below 

 

 

Now, the material properties for Aluminum have been specified. Lastly, (Click) Return To Project,  

 

Save your project periodically, as you are working. ANSYS does not have an auto-save feature.  

 

Step 2: 

Geometry: Attach the Geometry  

In order to attach the geometry, right click on the “Geometry” and either click on DM “New 

DesignModular Geometry” or import the geometry through “Import Geometry”  
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Step 3:  

Generate Mesh 
Go back to “project” right click or double click on “Model” and select “Edit”, click and a new window will 

open. 

 

To generate default mesh:  

First, (click) Mesh in the tree outline. Next, (click) Mesh > Generate Mesh as shown below 

 

 
 

To generate Size mesh 

In this section we will size the mesh, such that it has ten uniform elements. In order to size the mesh, first 

expand Sizing located within the 

Details of "Mesh" table. Next, set Element Size to 0.40 m, as shown below.  
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Now, (click) Mesh > Generate Mesh in order to generate the new mesh. You should obtain the mesh, that 

is shown in the following image. 

 

 
 

 

Step 4:  

Material Assignment 

At this point, we will tell ANSYS to assign the Aluminum material properties that we specified earlier to 

the geometry. First, (expand) Geometry then (click) Line Body, as shown below. 

 
 

 

 

Then, (expand) Material in the "Details of Line Body" table and set Assignment to Aluminum, as shown 

below. 
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Step 5: 

Assign Fixed Support 

First, (right click) Modal > Insert > Fixed Support, as shown below. 

 

 

 
 

Next, click on the “solve” button and get the results as shown below.  
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To see the model right click on the “graph” below the “geometry” window and select all. Right click again 

on the shaded blue region on the graph and click on the “Create Mode Shape Results”, “total 

deformation” 1 to 6 results will appear under the “solution (C6)” as shown below. 

 

 
 

Then, click solve to obtain the mode shapes “Total Deformation” results as shown below. Here, we will tell 

ANSYS to find the deformation for the first six modes. 
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Select “total deformation 1” to visualize the mode shape result 1, select the rest for mode shape 2, 3, 4,5 

and 6.  

 
 

In order to visualize and run the simulation result click the “play” as shown below. Then, we will be able to 

see the shapes of the six modes. Additionally, we will be able to watch nice animations of the six modes. 
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WORK TO BE CARRIED OUT: 

Based on your group select and use the given specifications below, and select the material properties 

of the corresponding material assigned from (Table 1: Material properties). All the dimensions from 

the given figures below are in mm.  

 BEAM TYPE MATERIAL ASSIGNED   

Group 1 I beam Aluminum  

Group 2 I beam Steel  

Group 3 I beam Titanium  

Group 4 T beam Aluminum  

Group 5 T beam Steel  

Group 6 T beam Titanium  

Group 7 O beam Aluminum  

Group 8 O beam Steel  

Group 9 O beam Titanium 

Group 10 L beam Aluminum  

Group 11 L beam Steel 

Group 12 L beam Titanium  

Group 13 Channel beam* Aluminum  

Group 14 Channel beam* Steel 

Group 15 Channel beam* Titanium  

* Channel Beam same dimension as I Beam, REMOVE FLANGE from one side. 
 

 
Figure 10: I Beam Dimensions  
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Figure 11: T Beam Dimensions  

 

Figure 12: O Beam Dimensions 
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Figure 13: L Beam Dimensions 

Table 2: Material properties  

Material(s) Young s modulus (E) 

[GPa] 
Poisson’s ration (v)   Density () 

[Kg/m3] 

Steel  

(Carbon steel) 
207 0.292 7850 

Titanium 

(Aluminum alloys) 
114 0.342 4430 

Aluminum (Aluminum alloys) 
71 0.334 2700 

 

1. Prepare your report based on the given template, your report should include pictures of all the 

major steps and they must be labelled/named.  

a. Abstract 

b. Introduction  

c. A brief procedure that includes (refer back to METHODOLOGY): 

i. Necessary steps. 

ii. Attach fixed support at one end. 

iii. All the images/pics of the main steps.  

iv. First, carry out the simulation based on the default setup of “default details of 

mesh”, then 

v. Carry out based on the given setups from table 2 as edited “details of mesh”:  
 

Table 3: “details of mesh” 

Relevance  100 

Relevance center  Fine  

Element size  20 mm  

Smoothing  High  

 

d. Results  

i. Under this section you are expected to show the solution of your simulation 

from the “edited details of mesh” only. 
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ii. Pics of all the 6 mode shapes analyzed from the edited “details of mesh”  are 

expected and must be labelled.  

iii. A table containing the mode shapes frequencies for both “default details of 

mesh” and “edited details of mesh”.  
 

Table 4: …………………… 

Mode shapes  1 2 3 4 5 6 

Frequencies        

 

e. Discussion and Conclusion  

i. Discuss on the results obtained. Provide a comparison mode shapes table of the 

“default details of mesh” and the “edited details of mesh” 
 

Table 5: ...... 

“default details of mesh” frequencies       

“edited details of mesh” frequencies       

 

ii. What Conclusions could you draw?  

iii. Based on the results obtained from section “e-i”, which one is better? And 

Why? What are the ways of improving the results?  

iv. Why the choice of Element Type is important in any FEA software? 

v. Which Element Type you chose and why? Please explain in detail. 

 

 

 

All the work carried out should be burn on CD/DVD and submitted together with hard copy  

of the report. (Hard Copy conditional to university opening, otherwise softcopy via Microsoft 

Teams Assignment) 
 PDF report  

 Figures of the main steps involved (see what is under METHODOLOGY) 

 Figures of the 6 mode shapes  

 Print preview and report preview files 

 ANSYS Simulation, rendered avi video file of the simulation. 

 

 

 
 


